Formatting,
Style, and
Citation Guide

© The Writing Center • Garrett-Evangelical Theological Seminary
# Formatting, Style, and Citation Guide

This guide covers the basics of academic writing in one place: guidelines for formatting papers correctly; writing style tips; examples of citations for a variety of sources, and abbreviations for books of the Bible. Find your topic below to go directly to the section you need.

<table>
<thead>
<tr>
<th>Part One: Formatting Papers</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margins</td>
<td>2</td>
</tr>
<tr>
<td>Font and size</td>
<td>2</td>
</tr>
<tr>
<td>Indentation</td>
<td>2</td>
</tr>
<tr>
<td>Spacing</td>
<td>2</td>
</tr>
<tr>
<td>Alignment</td>
<td>3</td>
</tr>
<tr>
<td>Paper heading</td>
<td>3</td>
</tr>
<tr>
<td>Paper title</td>
<td>3</td>
</tr>
<tr>
<td>Title page</td>
<td>3</td>
</tr>
<tr>
<td>Page numbers</td>
<td>3</td>
</tr>
<tr>
<td>Footnotes/endnotes</td>
<td>3</td>
</tr>
<tr>
<td>Bibliography</td>
<td>4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part Two: Writing Style</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using quotations</td>
<td>5</td>
</tr>
<tr>
<td>Capitalization</td>
<td>6</td>
</tr>
<tr>
<td>Numbers</td>
<td>6</td>
</tr>
<tr>
<td>Citing Scripture references</td>
<td>7</td>
</tr>
<tr>
<td>Language</td>
<td>7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part Three: Citing Your Sources</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Written documents</td>
<td>9</td>
</tr>
<tr>
<td>Book</td>
<td>9</td>
</tr>
<tr>
<td>Journal, magazine, newspaper, book review</td>
<td>12</td>
</tr>
<tr>
<td>Dictionary or encyclopedia entry</td>
<td>13</td>
</tr>
<tr>
<td>Ancient or classical writing</td>
<td>13</td>
</tr>
<tr>
<td>Bible commentary</td>
<td>14</td>
</tr>
<tr>
<td>Website content, blog post, social-media post, email</td>
<td>15</td>
</tr>
<tr>
<td>Course resource/handout, thesis, dissertation</td>
<td>15</td>
</tr>
<tr>
<td>2. Music, literary, and dramatic works</td>
<td>16</td>
</tr>
<tr>
<td>3. Interviews, presentations, and lectures</td>
<td>17</td>
</tr>
<tr>
<td>4. Digital media</td>
<td>17</td>
</tr>
<tr>
<td>5. Pictorial and graphic works</td>
<td>18</td>
</tr>
<tr>
<td>6. Statistics and data</td>
<td>18</td>
</tr>
<tr>
<td>7. Previous academic work</td>
<td>19</td>
</tr>
</tbody>
</table>

| Part Four: Abbreviations for Books of the Bible | 20 |
Part One: Formatting Papers

This section shows you how to format your papers so they follow the standard layout for academic writing, specifically the guidelines recommended in *A Manual for Writers of Research Papers, Theses, and Dissertations*, Ninth edition (commonly referred to as “Turabian”). You will use these guidelines for most papers you write, although in some cases, the professor may specify a different format. Formatting your papers correctly gives your work credibility and shows your readers that you understand the conventions of academic writing.

Margins
Leave a margin of one inch on all edges of the paper. The margin also applies to headers and footers, footnotes, and images. This should be the default setting in Microsoft Word; if it is not, change it by following these steps:

1. Choose the “Layout” tab on the top menu.
2. Click on the arrow under “Margins” at the left-hand side.
3. Choose “Normal” (one-inch margins on all sides).1

Font and size
All papers should be written in 12 pt. Times New Roman or another readable font such as Cambria. If the default setting for Microsoft Word is not Times New Roman or Cambria 12 pt., follow these steps to change it:

1. Place your cursor on the Font menu on the Home tab.
2. Click on the arrow in the right corner of the Font menu.
3. Choose “Regular” under Font style.
4. Choose “12” under Size.
5. Click “Set as Default” in lower left-hand corner.
6. In the dialogue box, choose to set the default for this document only or for all documents.

Indentation
The first line of each new paragraph should be indented one-half inch. Do not use spacing to indent. Follow these steps to set a one-half inch indentation for the first line as default:

1. Choose “Select All” from the Editing menu on the Home tab.
2. Place your cursor on the Paragraph menu on the Home tab.
3. Click on the arrow in the right corner of the Paragraph menu.
4. Look under the “Special” drop-down menu in the Indentation section.
5. Select “First Line.”

Spacing
Type only one space, not two, between sentences. The text should be double-spaced with no additional spacing before or after paragraphs. Here are the steps for setting double-spacing:

1. Place your cursor on the Editing menu on the Home tab.
2. Click on the arrow next to “Select” to see the pull-down menu.
3. Choose “Select All.”
Block quotations, footnotes, captions, bibliography entries, and long headings should be single-spaced, but with a blank line added between items.

Alignment
The text of the paper should be left-justified—aligned at the left-hand side. It should *not* be right-justified—aligned at the right-hand side. Here are the steps to set this alignment as default:

1. Place your cursor on the Paragraph menu on the Home tab.
2. Choose the “Align Left” image at the far left.

Paper heading
Paper headings may differ depending on the professor’s instructions; if no guidelines are given, include a heading at the top left margin of the first page with the following information: 1) your name; 2) professor’s name; 3) course name; and 4) date. The heading should be double-spaced. Do *not* type this into a header using the header function because it will appear on every page.

Paper title
Except for journal entries, discussion-forum posts, and other short writing assignments, most papers should have a title. Skip a line after the paper heading and center your title. Do *not* use underlining, bold type, all upper-case letters, or italic type (unless you are referring to the title of a book or journal).

Title page
Your professor may specify whether the paper should have a title page. Generally, title pages are for longer papers. The standard format for a title page includes the title, centered, one-third of the way down the page. On the lower one-third of the page, type your name on one line, the course title on the next line, and the date on the line below that.

Page numbers
No number should appear on the title page. The remaining pages of the paper should be numbered with Arabic numerals, beginning with 1 and running consecutively until the end. Page numbers should be centered at the foot of the page, at least three-fourths of an inch from the bottom edge. Here are the steps for creating automatic page numbers in the document:

1. Choose the “Insert” tab next to the “Home” tab on the top menu.
2. Place your cursor on the Header & Footer menu.
3. Click on the arrow next to “Page Number” to see the pull-down menu.
4. Click on the right arrow next to “Bottom of Page.”
5. Move your cursor to the left to choose “Plain Number 2.”

Footnotes/endnotes
Whether you *quote* from a source (use the exact wording of the original text); *paraphrase* (restate the author’s ideas in your own words); *summarize* (present a condensed version of the material); or *use an idea* (refer to concepts or theories from the original source), you must cite it with a footnote/endnote!

- The footnote provides specific location information for a quotation, paraphrase, or reference included in your writing—in case a reader wants to refer to a source.
Footnotes, which are most often used in seminary papers, are placed at the bottom of the page. Endnotes appear at the end of the paper, labeled as “Notes.”

Complete source information includes the author, title, publisher, place of publication, date, page number, etc. See pages 9–19 of this guide, “Part Three: Citing Your Sources,” for examples of different footnotes/citations.

The first time a note appears, it needs to provide complete source information.

After the first time, when a source is mentioned, it can appear in a shortened form, which includes the author’s last name, a shortened version of the title, and the page number.

Footnotes should be single-spaced, with one blank line between each.

The first line of each footnote is indented one-half inch (like a paragraph), and all subsequent lines are aligned with the left margin.

You also can use footnotes to cross-reference other pages in the paper, comment on material in more detail, or acknowledge other writers and researchers.

Follow these steps to insert footnotes into your paper:

1. Choose the “References” tab on the top menu.
2. In the Footnotes menu, click on “Insert Footnote.”
3. A number will appear after the text and at the bottom of the page.
4. Type in complete source information after the number at the bottom of the page.

**Bibliography**
The bibliography is a list of sources used in your paper. It includes the same information as the footnote but is formatted slightly differently and does not include a page number.

- Bibliography entries should be alphabetized by the author’s last name.
- If there is more than one entry by the same author, arrange them alphabetically by title (ignoring articles like “a” and “the”).
- Each entry should use a “hanging indent,” with the first line aligned with the left margin and all subsequent lines indented one-half inch. Entries should be single-spaced.
- Leave one blank line between each entry.

For other questions related to formatting, see pages 393–420 in the Turabian Guide (*A Manual for Writers of Research Papers, Theses, and Dissertations*, Ninth ed.).
Part Two: Writing Style

The types of writing you do in seminary will vary based on course requirements, subject area, and type of assignment. In every case, however, your audience will be a professor who expects a certain standard in your work. By following these simple guidelines, you can improve the quality of your writing.

Using quotations
The use of direct quotations from another source is an effective way to support your argument and bring life to your paper. It is your responsibility to verify the accuracy of the quotations and cite the sources accurately and completely (see pages 9–19, “Part Three: Citing Your Sources”).

- A quotation should be run into the text, with quotation marks surrounding it. A quotation of five lines or more should be set off as a block excerpt, indented five spaces from the left margin. Initial and closing quotation marks are not used with a block quotation. Any quotations within the excerpt should have double quotation marks. Here is an example:

  Present a prose quotation of five or more lines as a block quotation. Introduce the quotation in your own words in the text. If you introduce the quotation with a complete sentence, end the sentence with a colon. If you use an attribution phrase such as “notes,” “claims,” “argues,” or “according to” along with the author’s name, end the phrase with a comma. If you weave the quotation into the syntax of your sentence, do not use any punctuation before the quotation if no punctuation would ordinarily appear there.²

- If you choose to omit words in a quotation, use an ellipsis (…) to indicate the words left out. There should be one space before, between, and after each ellipsis point.

- Quotations should be punctuated as follows:

  ✓ .” (period is inside quotation marks at end of a quotation that is a sentence)
  ✓ ,” (comma is always inside quotation marks)
  ✓ ?” (question mark is inside quotation marks if punctuation applies to quotation itself)
  ✓ ”? (question mark is outside quotation marks if punctuation applies to whole sentence)
  ✓ ”; (semi-colon is always outside quotation marks)
  ✓ ”: (colon is always outside quotation marks)

- The initial letters of the quotation may be lower-case to fit its new context.

- Introduce a single-sentence quotation with a comma, longer quotations with a colon, except for those introduced by “that,” in which case there is no punctuation required.

  Augustine wrote that “The world is a book and those who do not travel read only one page.” Augustine said, “The world is a book and those who do not travel read only one page.”

Capitalization

Avoid excess capitalization in your writing. Here are some general guidelines to follow:

- **The word “church”** should be capitalized only if it is part of a name, as in “The service took place at St. Mark’s Church” or “He is a member of The United Methodist Church.” Otherwise, it should be in lower-case, as in “She attends church regularly” or “In the early church, there were many conflicts.”

- **Religions and denominations** are capitalized, as are their adherents, as in “Methodism,” “Judaism,” “Anglicanism,” or “Christian Science.”

- **Theological terms** such as “Christology,” “Eucharist,” or “Gnosticism” are capitalized, but their adjective forms are not: “christological,” “eucharistic, and “gnostic.” Similarly, “Scripture” and “Bible” are capitalized, but “scriptural” and “biblical” are not.

- **Descriptive titles** do not need to be capitalized, as in “the bishop of our church,” “the apostles,” or “the dean of the seminary.” If the title or descriptor is used as part of the name, however, it should be capitalized, as in “Paul the Apostle,” “Dean Johnson,” or “Bishop White.”

- **Terms referring to races** are generally not capitalized, although recent style changes suggest capitalizing the term “Black” and not capitalizing the term “white.” Terms such as “Hispanic,” “Latinx,” or “Asian-American” are capitalized.

- **Theological events and concepts** do not need to be capitalized: “atonement,” “creation,” “exile,” “exodus,” “fall,” “kingdom of God,” “resurrection,” “passion,” “original sin,” “promised land,” or “heaven.” The word “gospel” is not capitalized when referring to the good news, but it is capitalized when referring to a title of a work or division of the canon: “the Gospels” or “Mark’s Gospel.”

- **Philosophical terms**—such as “Truth,” “Beauty,” “the Good,” or “the One”—are capitalized, especially when used in a religious context. The terms “Othering,” “Otherness,” and “the Other” are all capitalized when referring to the state of being different.

Numbers

A common question in presenting numbers in a paper is whether to spell them out in words (twenty-seven) or give them in numbers (27).

- Numbers should be spelled out from one through one hundred; for example, “There are twenty-seven books in the New Testament.”

- Whole numbers one through one hundred followed by “hundred,” “thousand,” or “hundred thousand” are spelled out.

- When a number begins a sentence, it is always spelled out.

Citing Scripture references
Biblical references are given in Arabic numerals only; chapter and verse are separated by a colon with no space following it, as in Acts 27:1 or Exodus 20:3–17.

- In running text, books of the Bible are spelled out, as in “According to Genesis 1:27, God created man in his own image.”

- In parenthetical citations or in footnotes—or when there are many references in the text—abbreviations are appropriate: Gen. 1:27 or 2 Cor. 1:3–4. See the list of abbreviations in Part Four of this guide (pages 20–22).

- Numerals should not appear at the start of a sentence. It is incorrect to begin a sentence like this: “1 Corinthians 5:6 states that . . .”; instead, you would write, “First Corinthians 5:6 states that . . .”

- Versions of the Bible are cited in parentheses after each Scripture citation: (Gen. 1:27; New Revised Standard Version) or (Gen. 1:27; NRSV).

- If the passage appears in a block excerpt and is a continuation of a sentence, place the citation in parentheses after the last word of the passage, but before the period. For example:

  Then the Lord said to Noah:

  Go into the ark, you and all your household, for I have seen that you alone are righteous before me in this generation. Take with you seven pairs of all clean animals, the male and its mate; and a pair of the animals that are not clean, the male and its mate; and seven pairs of the birds of the air also, male and female, to keep their kind alive on the face of all the earth (Gen. 7:1–3).

- If the passage appears in a block excerpt that is separate from the sentence before it, then place the citation in parenthesis after the period.

  . . . all the earth. (Gen. 7:1–3)

Language
Many students believe that writing for the academic community means using academic jargon, multi-syllabic words, overly complex sentences, or pretentious language. But good writing is clear, direct, and unaffected; your goal is to be understood, not to sound erudite.

- **Avoid clichés, slang, and a too-casual tone.** While academic writing today is not as formal as it once was—your goal is to be clear, direct, and unaffected—it is different from informal written or spoken English. Avoid contractions (“will not” as opposed to “won’t”), a too-casual tone, or colloquial phrases (such as “I pulled an all-nighter to write this paper”).

- **Eliminate redundancy.** Students often use repetition—piling up adverbs and adjectives or using too many qualifiers such as “basically,” “really,” or “very”—to shore up arguments or to extend the page count of their papers. Wordiness stems from not having enough to say or not knowing how to say it. Eliminate the filler, and you will have a stronger paper.
Choose active voice. Most of you know by now that the use of passive voice—a sentence that puts the actor after the action, as in “Six hymns were sung by the children’s choir”—generally weakens your writing and makes your meaning harder to discern. Active verbs give your writing energy and keep the reader engaged. In certain cases, passive voice can be used strategically, in cases where the subject of the verb is important, as in “The Pentecost liturgy was enhanced by liturgical dance.”

Use parallel structure. Using parallel forms can make your writing more clear and powerful. Instead of writing, “God is omnipotent, has no beginning and no end, and we cannot understand God,” it is stronger to use a parallel structure such as, “God is omnipotent, eternal, and incomprehensible.”

Be specific. Vague language and ideas tell readers that the writer does not have enough concrete information to make a compelling point. A very general sentence such as “The Gospel of John was written by different people over time” does not tell the reader nearly as much as “The Gospel of John evolved from an early document based on a personal experience of Jesus, to a literary creation developed from other sources in the tradition, to the final New Testament Gospel included in the canon today.” Specific, descriptive words make your ideas clear, forceful, and interesting.

Watch for empty or inflated expressions. When you are tempted to use a longer phrase such as “in reference to” or “with regard to,” choose a simpler option such as “about” to convey the same meaning. Eliminate empty phrases to start a sentence, such as “it was found that” or “it is important to note that.” Do not begin your sentence with “In my opinion”! You are writing the paper, so the reader assumes it is your opinion. It is better to say, “my argument is . . .” or “my thesis is . . .”

Use gender-specific pronouns only when appropriate. In formal writing, it is now acceptable to substitute the plural “they,” “them,” “their” and “themselves” for the singular “he” or “she.” When referring to a specific person, the choice of pronoun depends on that individual—whose stated preference for a specific pronoun should be respected. When you are referring to a person who does not identify with a gender-specific pronoun—or you are not sure whether they do—using “they” and its various forms is preferable.

Part Three: Citing Your Sources

For all writing assignments, Garrett-Evangelical follows Turabian citation style, taken from *A Manual for Writers of Research Papers, Theses, and Dissertations*, Ninth edition. (Turabian style is exactly the same as Chicago style, as detailed in the *Chicago Manual of Style*, Seventeenth edition.)

You should use Turabian style for citations unless your instructor tells you otherwise. It is crucial that you cite all your sources—whether using someone else’s exact words or paraphrasing in your own words. The seminary uses the footnotes-bibliography version of Turabian style.

- The **footnote** provides specific location information for a quotation, paraphrase, or reference included in your writing—in case a reader wants to refer to a source. A full reference citation is given the first time a work is cited. After that, a shortened version is given, with the author’s last name, a shortened version of the title, and the page number.

- The **bibliography** is a list of sources used in your paper. It includes the same information as the footnote, is formatted slightly differently, and does not include a page number. Entries in the bibliography are listed alphabetically by the author’s last name; if there is more than one entry by the same author, arrange them alphabetically by title (ignoring articles like “a” and “the”).

The following examples represent sources you will encounter most often in seminary research and writing. If you do not have access to the Turabian Guide, you can check online for the Turabian Citation Quick Guide, the CMOS Citation Quick Guide, or the CMOS Full Guide Online.

1. **WRITTEN DOCUMENTS**

**Book with one author**


**Book with multiple authors**


Editor or translator in place of author


Editor or translator in addition to author


Organization as author


Revised edition


Volume in a series


**Multivolume work as a whole**


**Chapter in a single-author book**


**Essay in an edited collection**


**ONLINE RESOURCE: ELECTRONIC BOOK**


**Journal article**


**ONLINE RESOURCE: JOURNAL ARTICLE**


**Magazine article**


**Newspaper article**


**Book review**


Dictionary or encyclopedia entry


ONLINE RESOURCE: DICTIONARY OR ENCYCLOPEDIA ENTRY


Ancient or classical writing

N: 1. Augustine, *De civitate Dei* 20.2  

B: Because these works have been published in many versions and translations over the centuries, the facts of publication are less important than in other types of citations. For this reason, they are generally cited only in footnotes.

Modern editions of classical writing


**Single-volume Bible commentary**


**ONLINE RESOURCE: SINGLE-VOLUME BIBLE COMMENTARY**

[https://www-ministrymatters-com.turing.library.northwestern.edu/reader/9781426735509/chapter35.xhtml#chapter35.xhtml~q=hosea&i=2](https://www-ministrymatters-com.turing.library.northwestern.edu/reader/9781426735509/chapter35.xhtml#chapter35.xhtml~q=hosea&i=2).

[https://www-ministrymatters.com.turing.library.northwestern.edu/reader/9781426735509/chapter35.xhtml#chapter35.xhtml~q=hosea&i=2](https://www-ministrymatters.com.turing.library.northwestern.edu/reader/9781426735509/chapter35.xhtml#chapter35.xhtml~q=hosea&i=2).

**Multi-volume Bible commentary**


**ONLINE RESOURCE: MULTI-VOLUME BIBLE COMMENTARY**


**Web-page content**


**Blog post**


**Social-media post**


**Personal email**


B: Personal email messages are not included in the bibliography.

**Course handout or resource**


**Thesis or dissertation**


---

**2. MUSIC, LITERARY, AND DRAMATIC WORKS**

**Musical work**


   https://hymnary.org/text/great_is_thy_faithfulness_o_god_my_father.

**Movie**


**Play**


**Poetry**


3. INTERVIEWS, PRESENTATIONS, AND LECTURES

Interview


B: Interviews are typically not included in the bibliography.

Paper presented at a conference


Class lecture


4. DIGITAL MEDIA

Video


Podcast


5. **PICTORIAL AND GRAPHIC WORKS**

*Painting or other artwork*


6. **STATISTICS AND DATA**

*Public document*


*Citing statistics and original research source*


7. **PREVIOUS ACADEMIC WORK**

*Course paper*


*Group project*

N: 1. Nicholas Benson, Carl Johnson, and Sarai Post, “Church Decline in the Twenty-first Century” (class presentation, Theology of Evangelism, Garrett-Evangelical Theological Seminary, Evanston, IL, Fall 2020).

### Part Four: Abbreviations for Books of the Bible

**The Hebrew Bible**

These are the traditional abbreviations and commonly used shorter forms for books of the Hebrew Bible. Note that the shorter forms have no periods.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amos or Am</td>
<td>Amos</td>
</tr>
<tr>
<td>1 Chron. or 1 Chr</td>
<td>1 Chronicles</td>
</tr>
<tr>
<td>2 Chron. or 2 Chr</td>
<td>2 Chronicles</td>
</tr>
<tr>
<td>Dan. or Dn</td>
<td>Daniel</td>
</tr>
<tr>
<td>Deut. or Dt</td>
<td>Deuteronomy</td>
</tr>
<tr>
<td>Eccles. or Eccl</td>
<td>Ecclesiastes</td>
</tr>
<tr>
<td>Esther or Est</td>
<td>Esther</td>
</tr>
<tr>
<td>Exod. or Ex</td>
<td>Exodus</td>
</tr>
<tr>
<td>Ezek. or Ez</td>
<td>Ezekiel</td>
</tr>
<tr>
<td>Ezra or Ezr</td>
<td>Ezra</td>
</tr>
<tr>
<td>Gen. or Gn</td>
<td>Genesis</td>
</tr>
<tr>
<td>Hab. or Hb</td>
<td>Habakkuk</td>
</tr>
<tr>
<td>Hag. or Hg</td>
<td>Haggai</td>
</tr>
<tr>
<td>Hosea or Hos</td>
<td>Hosea</td>
</tr>
<tr>
<td>Isa. or Is</td>
<td>Isaiah</td>
</tr>
<tr>
<td>Jer. or Jer</td>
<td>Jeremiah</td>
</tr>
<tr>
<td>Job or Jb</td>
<td>Job</td>
</tr>
<tr>
<td>Joel or Jl</td>
<td>Joel</td>
</tr>
<tr>
<td>Jon. or Jon</td>
<td>Jonah</td>
</tr>
<tr>
<td>Josh. or Jo</td>
<td>Joshua</td>
</tr>
<tr>
<td>Judg. or Jgs</td>
<td>Judges</td>
</tr>
<tr>
<td>1 Kings or 1 Kgs</td>
<td>1 Kings</td>
</tr>
<tr>
<td>2 Kings or 2 Kgs</td>
<td>2 Kings</td>
</tr>
<tr>
<td>Lam. or Lam</td>
<td>Lamentations</td>
</tr>
<tr>
<td>Lev. or Lv</td>
<td>Leviticus</td>
</tr>
<tr>
<td>Mal. or Mal</td>
<td>Malachi</td>
</tr>
<tr>
<td>Mic. or Mi</td>
<td>Micah</td>
</tr>
<tr>
<td>Nah. or Na</td>
<td>Nahum</td>
</tr>
<tr>
<td>Neh. or Neh</td>
<td>Nehemiah</td>
</tr>
<tr>
<td>Num. or Nm</td>
<td>Numbers</td>
</tr>
<tr>
<td>Obad. or Ob</td>
<td>Obadiah</td>
</tr>
<tr>
<td>Prov. or Prv</td>
<td>Proverbs</td>
</tr>
<tr>
<td>Ps. (pl. Pss.) or Ps (pl. Pss)</td>
<td>Psalms</td>
</tr>
<tr>
<td>Ruth or Ru</td>
<td>Ruth</td>
</tr>
<tr>
<td>1 Sam. or 1 Sm</td>
<td>1 Samuel</td>
</tr>
<tr>
<td>2 Sam. or 2 Sm</td>
<td>2 Samuel</td>
</tr>
<tr>
<td>Song of Solomon or Sg</td>
<td>Song of Solomon (= Song of Songs)</td>
</tr>
<tr>
<td>Zech. or Zec</td>
<td>Zechariah</td>
</tr>
<tr>
<td>Zeph. or Zep</td>
<td>Zephaniah</td>
</tr>
</tbody>
</table>
### The New Testament

These are the traditional abbreviations and commonly used shorter forms for books of the New Testament. Note that the shorter forms have no periods.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acts</td>
<td>Acts of the Apostles</td>
</tr>
<tr>
<td>Apoc.</td>
<td>Apocalypse (= Revelation)</td>
</tr>
<tr>
<td>Col. or Col</td>
<td>Colossians</td>
</tr>
<tr>
<td>1 Cor. or 1 Cor</td>
<td>1 Corinthians</td>
</tr>
<tr>
<td>2 Cor. or 2 Cor</td>
<td>2 Corinthians</td>
</tr>
<tr>
<td>Eph. or Eph</td>
<td>Ephesians</td>
</tr>
<tr>
<td>Gal. or Gal</td>
<td>Galatians</td>
</tr>
<tr>
<td>Heb. or Heb</td>
<td>Hebrews</td>
</tr>
<tr>
<td>James or Jas</td>
<td>James</td>
</tr>
<tr>
<td>John or Jn</td>
<td>John (Gospel)</td>
</tr>
<tr>
<td>1 John or 1 Jn</td>
<td>1 John (Epistle)</td>
</tr>
<tr>
<td>2 John or 2 Jn</td>
<td>2 John (Epistle)</td>
</tr>
<tr>
<td>3 John or 3 Jn</td>
<td>3 John (Epistle)</td>
</tr>
<tr>
<td>Jude</td>
<td>Jude</td>
</tr>
<tr>
<td>Luke or Lk</td>
<td>Luke</td>
</tr>
<tr>
<td>Mark or Mk</td>
<td>Mark</td>
</tr>
<tr>
<td>Matt. or Mt</td>
<td>Matthew</td>
</tr>
<tr>
<td>1 Pet. or 1 Pt</td>
<td>1 Peter</td>
</tr>
<tr>
<td>2 Pet. or 2 Pt</td>
<td>2 Peter</td>
</tr>
<tr>
<td>Phil. or Phil</td>
<td>Philippians</td>
</tr>
<tr>
<td>Philem. or Phlm</td>
<td>Philemon</td>
</tr>
<tr>
<td>Rev. or Rv</td>
<td>Revelation (= Apocalypse)</td>
</tr>
<tr>
<td>Rom. or Rom</td>
<td>Romans</td>
</tr>
<tr>
<td>1 Thess. or 1 Thes</td>
<td>1 Thessalonians</td>
</tr>
<tr>
<td>2 Thess. or 2 Thes</td>
<td>2 Thessalonians</td>
</tr>
<tr>
<td>1 Tim. or 1 Tm</td>
<td>1 Timothy</td>
</tr>
<tr>
<td>2 Tim. or 2 Tm</td>
<td>2 Timothy</td>
</tr>
<tr>
<td>Titus or Ti</td>
<td>Titus</td>
</tr>
</tbody>
</table>
The Apocrypha
The books of the Apocrypha appear in Roman Catholic versions of the Bible, although not in Jewish and Protestant versions. These are the traditional abbreviations and commonly used shorter forms. Note that the shorter forms have no periods.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar. or Bar</td>
<td>Baruch</td>
</tr>
<tr>
<td>Ecclus.</td>
<td>Ecclesiasticus (= Sirach)</td>
</tr>
<tr>
<td>1 Esd.</td>
<td>1 Esdras</td>
</tr>
<tr>
<td>2 Esd.</td>
<td>2 Esdras</td>
</tr>
<tr>
<td>Jth. or Jdt</td>
<td>Judith</td>
</tr>
<tr>
<td>1 Macc. or 1 Mc</td>
<td>1 Maccabees</td>
</tr>
<tr>
<td>2 Macc. or 2 Mc</td>
<td>2 Maccabees</td>
</tr>
<tr>
<td>Pr. of Man.</td>
<td>Prayer of Manasses (= Manasseh)</td>
</tr>
<tr>
<td>Sir. or Sir</td>
<td>Sirach (= Ecclesiasticus)</td>
</tr>
<tr>
<td>Sus.</td>
<td>Susanna</td>
</tr>
<tr>
<td>Tob. or Tb</td>
<td>Tobit</td>
</tr>
<tr>
<td>Ws</td>
<td>Wisdom (= Wisdom of Solomon)</td>
</tr>
<tr>
<td>Wisd. of Sol.</td>
<td>Wisdom of Solomon (= Wisdom)</td>
</tr>
</tbody>
</table>
Notes

1. The steps outlined here are for students using Word for Microsoft 365 MSO; depending on the version of Microsoft Word you are using, these steps may vary slightly. Search for instructions for your version at support.microsoft.com.


Bibliography
